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Topic Overview

Day 1 Day 2 Day 3 Day 4
AM BIM Fundamentals | BIM e-Submission (Assignment — 3D part
& Revit Interface Guidelines & finish)
Template Overview
Starting a BIM Basic 3D modeling :
project: Project staircase, railing,

template, Grids & | roof, ceiling

Levels, Create (Assignment —

) 2D
views Documentation,
PM Site & Mass Family editor Family)
Modelling interface & simple
(Assignment — 3D family creation
Basic 3D modeling part) Basic 2D elements:
: Walll, floor, ramp, rooms, area, annofation,

dimension, tags,
coordinates, schedule,
sheets, titleblock, link
files, insert files, exporting
files.

doors & windows
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DAY 1
Basic Site & Mass Modelling
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Keyboard Shortcuts
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Annotate>Detail o Create Similar SX Points Select pinned elements Create=>Select; Insert>Select; Ann...
DL | Detail Line DE | Delete sz Close
P oM Micror - Draw Axis View Control Bar “ Select elements by face Create>Select; Insert=Select; Ann...
R Text MM Mirror - Pick Axis X Reveal Cons_tn’mts Drag elements on select... Create>Select; Insert=Select; Ann...
FR Find/Replace MV Move GD Graphic Display Options . . .
e OF Offset L Hidden Line Type Properties Create=Properties; Modify>Prope...
TG I Tag by Category PN Pin RY Ray Trace Properties PP Create>Properties; View=Windo...
Collaborate>Synchronize RE Scale SD Shaded Ctrl+1
RL/RW Reload Latest RO Rotate WF Wireframe VP
ER Editing Requests SL Split Element Function Keys
TR Trim/Extend to Corner F1 Displays Revit Help Family Category and Par... Create=Properties; Modify>Prope...
UpP Unpin F7 Spelling <
F8 Navigation Whee! L .
- Press new keys: 7 Assign == Remove
F10/AIt Keytips
Flip or rotate 90 degrees
Spacebar selected elements Import... ‘ ‘ Export... oK ‘ ‘ Cancel
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Tab 5
chain of elements
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Site Creation

Sketch a topo-surface, and then add property lines, a building pad, and parking and site components.
You can then create a 3D view of the site design or render it for a more realistic presentation.
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« Look at topo-surfaces in a site plan view or.a 3D view. When viewing a topo-surface,
consider the following:
« Visibility. You can control the visibility of topographic points. There are 2 topographic
point subcategories, Boundary and Interior. Revit classifies points automatically.
« Triangulation edges. Triangulation edges for topo-surfaces are turned off by default.
You can turn them on by selecting them from the Model Categories/Topography
category in the Visibility/Graphics dialog.
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Create Topo-surface: by Defining Points

1. Create a building site:
2. Inthe Project Browser, under Floor Plans, double-click Site Plan.
3. Inthe Ribbon, open the Massing & Site tab. The Model Site Panel click _ A (Topo-surface).

cposurface

4. On the Options Bar, for Elevation, enter -150 mm. (Continue entering-other point w different value)

5. Add points to the left of the building, as shown. The order of the point selection is not important

] 6. On the'Options Bar, for Elevation, enter -4000 mm.

|

fr : /. ¢Add.points near the center of the building, as shown.

1 Contour lines are displayed.
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Create Topo-surface: by Defining Points

8. On the Options Bar, for Elevation, enter -4300 mm.

9. Add points to the right of the building, as shown.
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10. In the Ribbon, on the Surface Panel, click «# Finish

Surface).
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Create Topo-surface: by Import CAD

—
.

Create a building site:

In the Project Browser, under Floor Plans, double-click Site.

In the Ribbon, open the Insert tab. At The Import Panel click (Import CAD).
Open 3D view

In the Ribbon, open the Massing & Site tab. The the Model Site"Panel click %\ (Topo-surface).

Toposurface

On the Edit Surface Ribbon, The Tool Panel click “Create From:Import” dropdown

g
)

Click “Select Import Instance” , Next in Drawing Area—click the CAD file just imported L

m ir
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.
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Create Topo-surface: by Import CAD

Add Points from Selected Layers

/. Innew pop up menu “Add Point from Selected Layers” - Check None — *:E
a. Select “C-TOPO-MAJR" & *
b. Select “C-TOPO-MINR” "
8. Completed the above selection with click OK — At the Edit Surface Panel click “Finish Surface™ v 4
s
Finist it
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Create Topo-surface: by Import CAD

9. To off the CAD : Right Click the 3D view at the “Project Browser” — Select Properties
10. Instance Properties — Graphics — Visibility/Graphics Overrides — Click Edit.

11. In "Import Categories” — un-check the CAD drawing that we imported earlier -
12. Click OK

13. In the “View Control Box" — Click Model Graphics Style — Change to
l‘.’.
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#  Instance Properties ot S
Eamily: System Famdy: 3D View
Type: 30 View v Edit Type...

Instance Parameters - Control selected or to-be-created instance

Parameter Value =

 Graphics 2
View Scale 18" =10
| Detail Level Medium

Visibility/Graphics Overndes . E“(_W —
Model Graphics Style Hidden Line

Graphic Display Options Edt... iE
Discipline Architectural

Shading with Edges

ﬂ Wireframe
7 Hidden Line
Sh.\d.ng
£ Shading with Edges
18 =10" BN G > ¢ ¢
(x| ,I:} x X 45
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Create Topo-surface: Contour Labels

You can label contour lines to indicate their elevations. Contour labels display in site plan views.
1. Create a topographic surface with different elevations.

2. Open asite plan view.

3. Click Massing & Site tab - Modify Site panel . (Label Contours).

4. Sketch aline that infersects one or more contour lines.

Labels display on the contour lines. (You may need to zoom.inito see the labels.) The label line itself is not visible
unless you select a label.
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Create Building Pad

Create a building pad surface, which will cut out the toposurface to the specified depth:
o)

Building
Rad

2. Inthe Modify | Create Pad Boundary tab, make sure _ IL Boundary: Line is selected

3. Click E (Rectangle).

4. Select the outer endpoint at the lower left of the building/as shown.

(Building Pad)

1. Inthe Ribbon (Massing & Site tab), on the Model Site Panel, click _

51 ‘Select the outer endpoint at the upper right of the building.

6. Inthe Ribbon, click‘i':i?(Finish).

=
Endpoint |
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Create Topo-surface Sub-regions

Toposurface subregions are areas that you sketch inside existing toposurfaces.

To create a subregion

« Open asite plan that displays a toposurface.

» Click Massing & Site tab Modify Site panel N\ (Subregion). Revit enters sketch mode.

JJ
+ Click ,,a[.‘.g ((Pick Lines) or use other sketch tools to create a’subregion on the toposurface.

To modify subregion boundaries
« Select the subregion.

« Click Modify | Topography tab Subregion panel 4, (Edit Boundary).

BCA ACADEMY

: d : : . :
+ Click J[:?( (Pick Lines) or use other sketch tools to modify the subregion on the toposurface.
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Add Parking Components

You can add parking spaces to a toposurface and define the toposurface as the parking component’s host.

To add parking components

1. Open a view that displays the toposurfaceto modify.

2. Click Massing & Site tab Model Site panel || (Parking Component).

Lill

Place the cursor on the toposurface and click to place the component. Place as many components as

desired. You can create an array of parking components.
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About Massing Studies

You can use massing studies to perform a variety of tasks.

* Create in-place or family-based mass instances that are specific to individual design options.

* Create mass families that represent the forms associated with often-used building volumes.

* Vary materials, forms, and relations between masses that represent.major components of a building or
development using design options.

e Study zoning compliance, both visually and numerically, by relating a proposed building mass to the zoning

 envelope and floor area ratio.

* Generate floors, roofs, curtain systems, and walls' from mass instances with control over element category, type,

and parameter values. Fully control regeneration of these elements when the mass changes.

Perimeter Analysis

‘Mass: Type : Level  Floor Perimeter

Rectangle 4 116m
—= ectangle ,,,,,,,,,,,,,,,,,,,,,,, e
e é&é}'{c‘_il'é”w O I Ty
e éé{éﬁgfé .................................... ey
" Rectangle | 5 115m
" Rectangle . 6 P 101 m
Rectangle 679 m
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Massing Tool

1. Click Massing & Site tab Conceptual Mass panel (In-Place Mass). C—T] 1 show Mass L_\,l H

L\'f e L Y

2. Enter a name for the in-place mass family, and click OK. BN 1 Ptace Mass |

3. The application window displays the conceptual design environment. ‘ e o vl =PAS J
Press F1 for more help

4. Create the desired shapes using the tools on the Draw panel.

5. For more information, see the following topics:

a. Forms
b. Profiles
c. Sketching

6. When you are finished, click Finish Mass.

*Do take note that all shape create in mass must in close loop
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Massing Studies

1. If you have not already done so, add levels to the project. Mass floors are based on levels defined in the project.
2. Select the mass.

3. You can select the mass in any type of project view, including floor plan, RCP, elevation, section, and 3D views.
4.  Click Modify | Mass tab Model panel (Mass Floors).

5. Inthe Mass Floors dialog, select each level that needs a mass floor, and click OK.

6. Initially, if you select a level that the mass does not intersect, the software does not create a mass floor for that level. However, if
you later resize the mass so that it intersects the specified level, thessoftware creates a mass floor on that level.

/. Mass floors

8. After creating mass floors, you can do any of the foellowing:

i
f

a. Select a mass floor to view its properties.(including area, perimeter, \ .................
exterior surface area, and volume) and assign a usage. Q
a. Tag mass floors. el
I Py ™
b. Create building floors from mass floors. e
ettt \
\

/\
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BU|Id|ng Maker Tool

To create a wall from mass faces
2. Open a view that displays the mass.
3. Click Massing & Site tab Model by Face panel @ (Wall by Face).
4. Inthe Type Selector, select a wall type.
5. On the Options Bar, select desired values for Level, Height, and Location.line.

6. (Optional) To create the wall from a single mass face, click Modify | Place Wall by Face tab Selection panel (Select Multiple) to
disable it. (It is enabled by default.)

/. Move the cursor to highlight a face.

8. Click to select the face.

(Wall by Face). “(Curtain Wall by Face). )
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Building Maker Tool

9. If the Select Multiple option is cleared, a wall is placed on the face immediately.

10. If Select Multiple is enabled, select more mass faces as follows:
a. Click an unselected face to add it to the selection. Click a selected face to remove it.
b. Multiple The cursor indicates whether you are adding (+) or removing (—) a face.
c. To clear the selection and start over, click Modify | Place Wall by Face tab*Multiple Selection panel (Clear Selection).

d. When the desired faces are selected, click Modify | Place Wall by Face.tab Multiple Selection panel Create Wall.
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